1. Introductions and Announcements
2. Minutes from Previous Meeting
3. Kansas State University
   a. New Series
4. Housekeeping Changes:
   a. Revised Series
      • Human Rights Commission
      • Department of Transportation
      • Department of Labor
      • Real Estate Appraisal Board
   b. Superseded to the General Schedule
      • Local General Schedule
      • Real Estate Appraisal Board
5. Other Business:
   a. ITAB Email Guidelines
   b. Future Meetings:
      • January 17, 2019
      • April 18, 2019
      • July 18, 2019
Present: Lisa Mendoza, designee of the Attorney General (chair)  
Matt Veatch, State Archivist (KSHS)  
Bill Sowers, designee of the State Librarian  
Philip Michael, designee of the Secretary of Dept. of Administration (DofA)  
Josh Michaelis, Director, Rice County Emergency Communications  
Heather Wilke, Staff Attorney, Kansas Department of Labor (KDOL)  
Megan Rohleder, Electronic Records Archivist (KSHS)  
Ethan Anderson, Government Records Archivist (KSHS)  
Mark Cole, Archives Specialist (KSHS)  
Via Phone: Michael Ronin, Kansas Department of Transportation (KDOT)

Meeting called to order at 8:40 a.m. and Ms. Mendoza began the introductions. Ms. Rohleder requested to add series 082-010 to the agenda. Ms. Mendoza requested to add a discussion of an open records request that the KSHS staff received and discuss what to do as a board.

Minutes: Previous meeting minutes were reviewed.

Motion: Mr. Veatch moved approval of meeting minutes as presented. Mr. Michael seconded, unanimous approval of April 19, 2017 meeting minutes.

Kansas Department of Labor: Ms. Rohleder presented the Electronic Record Keeping Plan (ERP) for the new Online System for Claims Administration Research/Regulation (OSCAR). Ms. Rohleder stated the ERP was endorsed by the Electronic Records Committee (ERC) as amended with clarification to C5.

Motion: Mr. Veatch moved to approve ERP as submitted. Mr. Sowers seconded, unanimous approval.

Mr. Anderson presented series 0204-296 and 0207-296 indicating revision necessary due to newly approved OSCAR ERP. Board discussion determined that K.S.A. 45-221 be amended on both series to K.S.A. 45-221(a)(1)(4)(30)(48).

Motion: Mr. Michael moved to approve revised entries as amended. Mr. Veatch seconded, unanimous approval.

Kansas Department of Transportation: Ms. Rohleder presented the KCARS/OnBase ERP. Ms. Rohleder indicated that the ERC has reviewed twice before and both times requested additional information. At the September 18, 2018 ERC meeting, section 3.4 still required more detailed
clarification before ERC would endorse. On June 21, 2018, KDOT provided the information to Ms. Rohleder and the amended ERP was forwarded to ERC members via email. ERC members endorsed the updated ERP.

**Motion:** Mr. Veatch moved to approve the amended ERP as submitted. Mr. Michael seconded, unanimous approval.

Mr. Anderson presented the new series “Kansas Motor Vehicle Crash Report Data” for review. It was determined that the comments section was not needed and removed.

**Motion:** Mr. Veatch moved to approve new series as amended. Mr. Sowers seconded, unanimous approval.

**Local General Schedule:** Mr. Anderson presented the new series “Contractors Licensing/Trades Certification” for County Engineer/Planning records. The board reviewed and no further discussion.

**Motion:** Mr. Sowers moved to approve new series as presented. Mr. Michael seconded, unanimous approval.

Mr. Anderson then continued to the revised records series 0003-100 for Emergency Communications. The existing series was broadened to include records generated by the “Next Generation 911” program. The board discussed and determined both the retention period and disposition type be changed to “See Comments.”

**Motion:** Mr. Sowers moved to approve as amended, Mr. Veatch seconded. Unanimous approval.

**Office of the Attorney General-Legal Opinions & Gov’t Counsel (LOGIC) Division:** Ms. Rohleder indicated that series 0186-082 was inadvertently missed from previous board meeting approval of superseded records into 0053-082. The board reviewed with no further discussion.

**Motion:** Mr. Veatch moved to approve as submitted. Mr. Michael seconded, unanimous approval.

**Housekeeping:** Mr. Anderson briefly went over the housekeeping changes and board accepted as presented.

**Other Business:** Ms. Mendoza began discussion regarding a letter request made directly to the SRB. Ms. Rohleder provided a redacted copy of the letter for board to review. Determined that response letter from the board be sent to the requestor.

**Motion:** Mr. Veatch moved that the board request assistance from the Department of Administration in drafting a response to the letter and sending a response on behalf of the SRB. Mr. Sowers seconded, unanimous approval.

The final order of business was to confirm the proposed future meeting on October 18, 2018. With nothing further to discuss, the board adjourned at 9:25 a.m.
1. **Agency:** Kansas State University

2. **Records Officer:** Ryan Leimkuehler  
   **Phone:** 785-532-5013

3. **Appraising Archivist(s):** Ethan Anderson

4. **Date of Appraisal:** 10/02/2018

5. a) **Total records – No. of Series:** 2
   b) **New series – No. of Series:** 2
   c) **Revised existing series – No. of Series:** 0
   d) **Obsolete schedule entries – No. of Series:** 0
   e) **Series superseded by other schedule entries – No. of Series:** 0

6. **Archival/Permanent records – No. of Series:** 0

7. **Appraisal Narrative:**

   Ryan Leimkuehler contacted KSHS staff about creating two records series, Conflict of Interest Records and Patron Suggestions and Comments Form. The former is kept electronically in K-State’s ImageNow system. An Electronic Recordkeeping Plan for ImageNow passed the Electronic Records Committee December 20, 2016.
Retention/Disposition Schedule Entries

367-001
Kansas State University

Conflict of Interest Records (Series Unknown)
This series is comprised of Conflict of Interest Records which includes Conflict of Interest Forms and Consulting Forms. In compliance with Kansas Board of Regents (KBOR) policy, Kansas State University (KSU) requires all unclassified faculty and staff with 100% time appointments to annually file Annual Declaration and Disclosure records. Unclassified faculty and staff who hold fractional appointments and have potential conflicts of time or interest are also required to file disclosure records.

Entry Status: Draft
Recommended Status: Approve As New
Retention Period: Retain for length of employment plus 3 calendar years
Disposition: Destroy
Restrictions: Portions may be restricted under KSA 45-221(a)(4)(6)
Comments: The Division of Human Capital Services is the office of record.
Schedule Authority: Agency Schedule
Last Surveyed 02 October 2018
Record Copy: Paper, Electronic
Electronic Recordkeeping Plan Not Required
Remarks: 10/2/2018: R. Leimkuehler from K-State contacted records management staff to add record series.

Patron Suggestions and Comments Form (Series Unknown)
This form is used by K-State Libraries staff to record patron comments and suggestions. Libraries staff will submit complaints, suggestions, and compliments into the form and generate reports from the data received.

Entry Status: Draft
Recommended Status: Approve As New
Retention Period: 5 calendar years
Disposition: Destroy
Restrictions: Portions may include KSA 45-221(a)(4)(8)(23)
Comments: Libraries Office of Planning and Assessment is the office of record.
Schedule Authority: Agency Schedule
Last Surveyed 02 October 2018
Record Copy: Electronic
Electronic Recordkeeping Plan Not Required
Remarks: 10/2/2018: R. Leimkuehler from K-State contacted records management staff to add record series.
Housekeeping Changes Since 21 July 2018
17 October 2018

Housekeeping Edit

058-001
Kansas Commission on Human Rights
Public Hearing Files (Series 0022-058)
Description: Docket sheet, trial transcript, brief, pleadings, etc. relating to a trial conducted by a hearing officer based upon probable cause resulting from the investigation conducted by the Human Rights Commission.

276-003
Kansas Department of Transportation
Division of Administration
Bureau of Fiscal Services
Vouchers - Purchase (Series 0008-276)
Description: Copies of documents used to order and pay for goods and services: DA forms 100 thru 109 and DA-120.

296-041
Department of Labor
Division of Workers' Compensation
Utilization and Peer Review Files (Series 0215-296)
Description: Documents relating to utilization and peer review of entities providing health care services pursuant to the Workers' Compensation Act to assess the appropriateness of treatment and fees charged.
543-001
Real Estate Appraisal Board

Appraiser Licensing Files (Series 0004-543)
Description: Application and supporting documentation relating to individuals applying or renewing a license to appraise real estate in Kansas as required by the board.

Obsolete

000-100
Local Government Records
General Schedule/All Offices

Legal/Public Notices (Series 0053-100)
Description: Announcements appropriately published to notify the general public of an auction, legal proceeding, election, etc.
Change: two entries exist for this series on the general schedule-- eanderson, 20 August 2018

Superseded series

543-001
Real Estate Appraisal Board

Accounts Receivable Records (Series 0002-543)
Description: Documents related to the collection of payments due the agency: copies of invoices, correspondence, DA forms 32, etc.

Annual or Special Reports (Series 0003-543)
Description: General and specific reports on agency activities.

Contracts (Series 0008-543)
Description: Legal agreements with individuals and organizations. Includes all associated documents, eg. DA-146 series.
Correspondence - Policy Related (Series 0009-543)
Description: Incoming and outgoing letters and memoranda that state or form the basis for policy, set precedent, or record important events in the operational and organizational history of the agency.

Correspondence - Routine (Series 0010-543)
Description: Incoming and outgoing letters and memoranda which pertain only to routine matters handled in accordance with existing policy and procedures: requests for information, letters of transmittal, etc.

Employee Personnel Files (Series 0011-543)
Description: Documents associated with the employment of specific personnel: employee evaluation forms, applications for employment, and other personnel materials.

Employee Time Report Records (Series 0012-543)
Description: Records documenting time worked by individual employees on a daily, weekly, or monthly basis: time sheets, time cards, attendance reports, absence reports, sign-in/out sheets, etc.

Legislative Relations Files (Series 0015-543)
Description: Copies of bills and statutes, drafts of legislation, notes, correspondence, testimony, and other miscellaneous documents related to various legislative activities.

Minutes (Series 0017-543)
Description: Proceedings of regular or special meetings of committees, commissions, and other standing or ad hoc organizations.

SHaRP Reports (Series 0018-543)
Description: Computer reports concerning agency payroll issued on a periodic basis from the Division of Accounts and Reports to agencies in the Statewide Human Resources and Payroll Project.

STARS Reports: Daily Financial (Series 0019-543)
Description: Computer reports regarding agency financial status issued on a daily basis from the Division of Accounts and Reports to agencies in the Statewide Accounting and Reporting Systems.

STARS Reports: Monthly Financial (Series 0020-543)
Description: Computer reports regarding agency financial status issued on a monthly basis from the Division of Accounts and Reports to agencies in the Statewide Accounting and Reporting Systems.
STARS Reports: Yearly Financial (Series 0021-543)  
Description: Computer reports regarding agency financial status issued on a yearly basis from the Division of Accounts and Reports to the Statewide Accounting and Reporting Systems.

Technical Reference Files (Series 0022-543)  
Description: Copies of documents retained strictly for convenience of reference that are not part of official files: copies of external reports, studies, periodicals, books, brochures, catalogs, vendor lists, etc.

Vouchers - Receipts (Series 0024-543)  
Description: Copies of documents used to transfer funds received by agencies from individuals and organizations into their particular accounts: forms DA-3 series.
The State of Kansas
Information Technology Executive Council

Information Technology Guideline #6401– Managing Electronic Mail

These Guidelines were drafted by the Electronic Records Committee, a subcommittee of the Kansas Information Technology Advisory Board (ITAB), and its E-Mail Task Force.

Scope

These guidelines apply to state and local government agencies in the State of Kansas. Other governmental entities may also wish to follow these guidelines as appropriate.

Intent and Purpose

The intent of these guidelines is to provide and explain requirements, guidelines and best practices for electronic mail (e-mail) messages that meet the criteria for records as defined by Kansas Statutes Annotated (KSA) and Kansas Administrative Regulations (KAR), and come under the jurisdiction of the State Records Board.

These guidelines have a two-fold purpose. First, they are intended to assist agency employees in complying with Kansas public records law in their use of e-mail. Second, the guidelines promote best practices and suggestions that facilitate the effective capture, management, and retention of electronic messages as public records.

Records are a resource critical to the operation of state government. They serve as the organizational memory, providing evidence of past activity and forming the basis for future actions. State records may furnish proof of a particular action, contain information that protects the rights of individuals or the government, and document decisions made during the course of state business. When controlled systematically, records are an asset; but when managed haphazardly, they are a liability. Agencies have the responsibility to all citizens of Kansas to manage state records effectively and efficiently, regardless of the technology used to create the records.

Introduction

Electronic mail systems, commonly called e-mail, are becoming the communications method of choice for many public officials and public employees in Kansas. E-mail messages are often used as communication substitutes for the telephone as well as paper-based means of information transmission. This combination of communication and record creation/keeping has created ambiguities on the status of e-mail messages as records.

The management of e-mail systems touches on nearly all functions for which a government agency is dependent on recordkeeping: privacy, administration, vital records management, administrative security, auditing, access, and archives. The need to manage e-mail messages and systems properly, then, is the same as for other records keeping systems -- to ensure compliance with Kansas laws concerning the creation of, retention of, and access to public records.

Government agencies that use electronic mail have an obligation to make employees aware that e-mail
messages, like paper records, must be retained and destroyed according to established records management procedures. Agencies should establish procedures and capabilities to facilitate e-mail records management. Procedures and system configurations will vary according to the agency’s needs and the particular hardware and software in place.

These guidelines are based partly upon the work done by the Ohio State Historical Society, Maine State Archives, Delaware State Archives and Florida Department of State (see bibliography for citations). Their work is included here with their kind permission. We appreciate their expertise and generosity.

Definitions

E-mail systems are store-and-deliver software systems that transport messages from one computer user to another. E-mail systems range in scope and size from a local area network e-mail system that shuffles messages to users within an agency or office; to a wide area network e-mail system that carries messages to various users in various physical locations; to Internet e-mail that allows users to send and receive messages from other Internet users around the world.

E-mail messages are electronic documents created and sent or received by a computer system. This definition applies equally to the contents of the communication, the transactional information, and any attachments associated with such communication. Thus, e-mail messages are similar to other forms of communicated messages, such as correspondence, memoranda, and circular letters.

Legal Requirements

Kansas Statutes Annotated (KSA) includes no specific definition for electronic mail; however, KSA Section 45-402(d) provides the following definition:

- Government records means all volumes, documents, reports, maps, drawings, charts, indexes, plans, memoranda, sound recordings, microfilms, photographic records and other data, information or documentary material, regardless of physical form or characteristics, storage media or condition of use, made or received by an agency in pursuance of law or in connection with the transaction of official business or bearing upon the official activities and functions of any governmental agency.

Clearly, an e-mail message is a document or item created or received by a public office. Whether the e-mail serves to document the organization, functions, policies, decisions, procedures, operations or other activities is the deciding factor as to its status as a record. This is true of any communication, whether electronic or paper.

E-mail messages that meet the criteria of the definition of a record must be scheduled and retained for the appropriate time period before disposition. Scheduling e-mail is discussed in detail below.

E-mail messages that meet the criteria of the definition of a record may be considered public records and must be available to the public. A record must meet the definition of a public record as defined in the Kansas Open Records Act. This definition is found in KSA 45-215 through 45-223, which states in part:

- Public record means any recorded information, regardless of form or characteristics, which is made[,] maintained or kept by[,] or is in the possession of any public agency....

All public records shall be open for inspection by any person, except as otherwise provided by this act, and suitable facilities shall be made available by each public agency for this purpose.
As with any format, an e-mail message is considered a public record unless it falls under one of the exceptions listed in the Open Records Act, or other state and federal statutes and regulations. These records must be maintained and made accessible to the public upon request through the appropriate retention period.

**Retention and Scheduling Requirements**

E-mail itself is not considered a record series or category. It is a means of transmission of messages or information. Like paper or microfilm, e-mail is the medium by which this type of record is transmitted. Just as an agency cannot schedule all paper or microfilm records together under a single retention period, an agency cannot simply schedule e-mail as a record series. Rather, retention or disposition of e-mail messages must be related to the information they contain or the purpose they serve. The content, transactional information, and any attachments associated with the message are considered a record (if they meet the KSA criteria). The content of e-mail messages may vary considerably, and therefore, this content must be evaluated to determine the length of time the message must be retained.

*Simply backing up the e-mail system onto tapes or other media, or purging all messages after a set amount of time are not adequate strategies for managing e-mail.*

For more information on records management in your agency, contact your agency's records officer or the Records Management Section of the Kansas State Historical Society at (785) 272-8681, EXT. 288.

For the purposes of this document, there are four categories of e-mail retention: **non-record messages**, **transitory messages**, **intermediate messages**, and **permanent messages**. An example of a mailbox with filed email messages is included as Appendix I.

**Non-Record Materials**

E-mail messages that do not meet the criteria of the KSA definition of a record may be deleted at any time, unless they become part of some official record as a result of special circumstances. These types of messages may include:

**Personal Correspondence**

Any e-mail not received or created in the course of state business, may be deleted immediately, since it is not an official record: the *Let's do lunch* (not a State-business lunch) or *Can I catch a ride home* type of note.

**Non-State Publications**

Publications, promotional material from vendors, and similar materials that are publicly available to anyone, are not official records unless specifically incorporated into other official records. In the electronic world, this includes e-mail list messages (other than those you post in your official capacity), unsolicited promotional material (spam), files copied or downloaded from Internet sites, etc.

These items may be immediately deleted, or maintained in a Non-Record mail box and deleted later, just as you might throw away the unwanted publication or promotional flyer.

However, for example, if you justify the purchase of a new office copier by incorporating the reviews you saved from a business equipment electronic mailing list in your proposal to your boss, those list messages become official records and must be retained in accordance with the retention schedule for purchasing proposals. Users should realize that depending on the settings of the e-mail system, messages deleted from an inbox may remain on the system anywhere from one to sixty days, or longer. See Appendix II.
Official Records -- Retain As Required

E-mail messages that meet the definition of a record in the KSA are official records and must be scheduled, retained and disposed of as such. These official records fall into the following categories:

Transient Retention

Much of the communication via e-mail has a very limited administrative value. For instance, an e-mail message notifying employees of an upcoming meeting would only have value until the meeting has been attended or the employee receiving the message has marked the date and time in his/her calendar.

Transitory messages do not set policy, establish guidelines or procedures, certify a transaction or become a receipt. The informal tone of transitory messages might be compared to a communication that might take place during a telephone conversation or conversation in an office hallway. These types of records are transient documents and can be scheduled using the Kansas State Records Management General Retention and Disposition Schedule:

- Transient Documents: Includes telephone messages, drafts and other limited documents, which serve to convey information of temporary importance in lieu of oral communication.
  Retention: Until no longer of administrative value, then destroy.

Intermediate Retention

E-mail messages that have more significant administrative, legal and/or fiscal value but are not scheduled as transient or permanent should be categorized under other appropriate record series. These may include (but are not limited to):

- Routine Correspondence: Includes incoming and outgoing letters and memoranda
  Retention: Retain until no longer useful, then destroy.

- Activity Reports: Internal documents used to compile statistics on agency activities: traffic reports, activity logs, etc.
  Retention: Retain 2 fiscal years, then destroy.

Permanent Retention

E-mail messages that have significant administrative, legal, fiscal and/or historical value, and are scheduled as permanent, also should be categorized under the appropriate record series. These may include (but are not limited to):

- Minutes: Proceedings of regular or special meetings of committees, commissions, and other standing or ad hoc organizations.
  Retention: Retain until no longer useful, then transfer to the archives.

- Policy Statements: Original copies of formal explanations of agency policies and procedures.
  Retention: Retain until no longer useful, then transfer to the archives. Retain convenience copies until no longer useful, then destroy.

Not all e-mail messages will fall into these record series. For more suggested retention periods, consult the Kansas State Records Management General Retention and Disposition Schedule and your agency's retention schedule.
Guidelines and Best Practices for Managing E-mail

Record Copy E-mail

E-mail users should be aware that e-mail messages are often widely distributed to a number of various recipients. Determining which individual maintains the record copy of the message, i.e. the original message that must be retained per the retention schedule, is vital to e-mail management. If the holder of the record copy is not identified and aware of his/her responsibility, the agency may find that no one retains the message or that everyone retains the message. Neither of these scenarios is appropriate.

For example, agency policy documents which are transmitted to multiple recipients via an e-mail system need not be maintained by each recipient beyond his or her need for this information if record copy responsibility is established so that the record is maintained by some office or agent for its established retention period. In this example, a logical record copy responsibility rests with the creator of the policy document. Prompt deletion of duplicate copies of e-mail messages from an e-mail system makes the system as a whole much easier to manage and reduces disk space consumed by redundant information.

*Generally speaking, the individual who sends an e-mail message should maintain the record copy of the message. However, the varied uses and wide distribution of e-mail may result in many exceptions to this rule that will have to be dealt with internally.*

Filing

Non-transitory e-mail messages should be filed in a way that enhances their accessibility and that facilitates records management tasks. Agencies should set up or modify e-mail systems to facilitate records management and appropriate filing systems (see Appendix II for more detail). Procedures and systems configurations will vary according to the agency's needs and the particular hardware and software in use.

In addition to the IN and OUT boxes that come with a mail system, there is usually the option of creating other “mailboxes” or “folders.” After brief periods in the IN-OUT boxes, messages should be transferred to other boxes, based on business and retention requirements. Examples are provided in Appendix I.

*Employees should be responsible for classifying messages they send or receive according to content, the agency's folder/directory structure and established records series.*

Distribution Lists

If a message is sent to a “distribution list” (not an electronic mailing list, but a specified list of individuals), a copy of the members of that list must also be kept for as long as the message itself. It is of little value to know that the “Emergency Alert!” notice went to “Security Team,” without knowing whether Thomas S. received the message. Nicknames present a similar problem.

Distribution lists may be updated over time, and the list that a message was sent to may change between the time the message was sent and the time a decision is made regarding the record status of that message. The metadata for a message should include all recipients of a message, and should list members of a distribution list.
Subject Lines

Fill in the subject line on your e-mail both to help the recipient identify and file messages, and to help file the OUT box messages that must be retained for some period. Subject lines should be as descriptive as possible.

The following are some examples of poor and good subject lines for the same message...

<table>
<thead>
<tr>
<th>Poor or confusing subject lines</th>
<th>Better, descriptive subject lines</th>
</tr>
</thead>
<tbody>
<tr>
<td>“helpful info”</td>
<td>“contact info”</td>
</tr>
<tr>
<td>“report”</td>
<td>“quarterly financial report”</td>
</tr>
<tr>
<td>“minutes”</td>
<td>“Jan 99 board minutes”</td>
</tr>
<tr>
<td>“important”</td>
<td>“revised admin. procedures”</td>
</tr>
<tr>
<td>“news”</td>
<td>“new agency head appointed”</td>
</tr>
</tbody>
</table>

Subject lines can also be used to aid in the retention of messages. Retention codes, record series titles, or retention period information can be added at the end of the descriptive subject line to facilitate easy routing of sent e-mail into appropriate folders to manage messages. See appendix II for more information.

Storage of E-mail

It is recommended that agencies explore three options when retaining records from an e-mail system: on-line storage, near-line storage, and off-line storage. It is important to remember that messages only have to be retained and stored for as long as the retention period requires. Very few messages must be maintained for a long period of time or permanently. The storage method of e-mail may also depend on the retention period of the record. Messages that need to be retained for six months should be relatively easy to maintain on the current mail system and then delete. Storage decisions for messages that need to be retained permanently will more require careful consideration.

Each of these options carries with it benefits and disadvantages and may be affected by an agency's information technology environment. In all these scenarios it is important to incorporate metadata considerations into the storage decision. (In this context metadata refers to information such as sender, recipient, date, routing, subject lines, system information and manuals, etc.)

On-line Storage

On-line storage is defined as storage of e-mail messages, metadata, and attachments in an e-mail system that is being used at an agency. The system in use does not necessarily have to be the same throughout the retention. For example, a message stored in “GroupWise Mail” may also be accessed, read, and then stored again by using “Outlook Mail.”

On-line storage maintains the full functionality of the e-mail message, and allows users to recall the message at any time for reference or responding. A disadvantage of on-line storage is the potential costs and effects of storage on the performance of the e-mail system. Any solution to e-
mail retention, which includes on-line storage, should be done only after consultation with the agency information resource manager and the agency network administrator (see Appendix II for more details about considerations for on-line storage).

One method of on-line storage that is a feature of many e-mail systems currently available is the “Archive” feature. “Archiving” allows the user to move messages to a designated database on a local drive while maintaining the messages in a format that is readable by the e-mail system. This function can decrease network space used by the system while allowing the user to read the messages in the format in which they were received. However, this feature does not insure that the messages will be maintained with their full functionality if the system is upgraded, or if a new e-mail software package replaces the first. See Appendix II for more information.

Near-line Storage

Near-line storage is defined as storage of e-mail messages, metadata, and attachments in an electronic record keeping system. This type of storage requires that the message, metadata, and attachments be removed from the on-line e-mail system and stored in an electronic format. For example, a message stored in an on-line e-mail system can be saved to a file on a local hard drive. The file should be stored in a format that is compatible with agency operations, and filed according to filing practices established by the agency and/or user.

Near-line storage allows the user to maintain a moderate amount of functionality, in that e-mail messages stored near-line can be retrieved and referenced electronically. In storing e-mail messages, metadata, and attachments, users should be careful to maintain a filing system, which is consistent with established practices. This includes filing sequences as well as the use of naming conventions for computer files. In addition, users may want to consider “protecting” such records from alteration.

Off-line storage

Off-line storage is defined as the storage of e-mail messages, metadata, and attachments outside of an electronic record-keeping environment. The clearest example of this type of storage is to simply print out an e-mail message to paper, with its contextual information and attachments in place, for filing within existing filing systems in the agency.

Off-line storage dramatically reduces the functionality, in that e-mail messages are no longer searchable or retrievable in electronic form. However, off-line storage offers users the ability to integrate the filing of records in e-mail systems within existing hard-copy filing systems in agencies. Any e-mail messages, metadata, and attachments stored off-line should be done in a manner consistent with agency practice.

E-mail Messages --- Rules of Evidence and Legal Discovery

Agency personnel should be familiar with both state and federal “rules of evidence” requirements. For records maintained in electronic information systems, including e-mail systems, courts concentrate on assurances that records, and the systems in which the records are created and maintained, are reliable. The reliability of the process or system used to produce records, not the type of media or technology used, determines the admissibility of records in evidence. Moreover, the federal rules of evidence place the burden for the identification of relevant records on the record creator, and often within a ninety-day time period.
At a minimum, agency personnel should ensure the following:

- e-mail systems used to create, receive and maintain e-mail messages have full, complete, and up-to-date systems documentation;
- e-mail systems follow all recommendations for system security;
- complete systems backups are regularly and consistently performed;
- e-mail system retains all data and audit trails necessary to prove its reliability as part of the normal course of agency business;
- the record copy of a message is identified and maintained appropriately; and
- backup procedures should be coordinated with disposition actions so that no copies of records are maintained after the retention period for the records has expired.

Again, agency records officers need to plan for records maintenance and record copy responsibilities for the records system to meet requirements for reliability and legal records disposition.

Public officials and agency employees should also keep in mind that e-mail messages, just like paper records, might be subject to discovery if litigation is initiated against their agency. E-mail accounts are provided to government employees for conducting public business. Employees and public officials may be required to provide access to their e-mail system under these circumstances. However, the potential for discovery proceedings does not release an agency and its employees from maintaining e-mail messages that have record status according to an approved Retention and Disposition Schedule.

The e-mail system should allow the server administrator to prevent scheduled destruction of records, which are needed for legal and/or audit purposes.

Access

A major challenge for agency records officers is to guarantee that records maintained in electronic information systems are accessible and usable for the entire length of the retention period. Rapid changes and enhancements to both hardware and software compound this challenge. As many e-mail systems have limitations in storage space that cause operational problems when messages are stored in the system beyond a specific period (such as sixty or ninety days), procedures must be in place to transfer records from the e-mail system to another electronic records keeping system to meet retention requirements.

Messages should be maintained in a format that preserves contextual information (metadata) and that facilitates retrieval and access.

The system should allow deletion of messages once their retention periods expire.

Beyond this generic challenge of technology change, there are more mundane, but equally critical steps that must be in place to ensure that records created by e-mail systems can be located and retrieved when required. A central step is a system of standardized naming conventions and filing rules within the e-mail systems.

E-mail messages should be indexed in an organized and consistent pattern reflecting the ways in which records are used and referenced. Records maintained electronically, including e-mail messages, have an
advantage over conventional “hard copy” document filing systems in that indexing for multiple access points is relatively simple and inexpensive, provided an effective indexing framework is in place. Planning records indexing and retrieval points is time well spent. Unnecessary time needed to retrieve electronic records is not productive staff time, and is an annoyance to the public as well. See Appendix I for more information about filing e-mail messages to enhance access.

Messages should be stored in a logical filing system that is searchable by multiple data elements.

Responsibility

Roles and responsibilities of agency personnel should be clearly defined. Employees must understand and carry out their role in records management and agencies must ensure compliance with agency procedures and Kansas law. Unauthorized users should not be able to access, modify, destroy or distribute records.

Agency administrators, individual agency employees, records managers, information technology (IT) managers and server administrators share responsibility for managing electronic records. Agencies should clearly identify the roles of each, adopt procedures, train staff and monitor compliance on a regular basis. The creator or recipient should make decisions regarding messages. The agency should take appropriate measures to preserve data integrity, confidentiality and physical security of e-mail records.
Appendix I -- Sample Filing Scheme for Electronic Mail

This sample filing scheme illustrates how electronic mail can be filed in accordance with the electronic mail guidelines and the Kansas State Records Management General Retention and Disposition Schedule. Applicable sections of the General Schedule are provided in brackets.

**Non-Record Messages** - Delete at will

**Personal Messages**
- Family
- Friends
- Miscellaneous

**Transitory Messages** - Retain until no longer useful, then destroy.

**Drafts**
- Publications
- Reports
- Memos

**Meeting Notices**

**Intermediate Retention Messages** - Delete per Retention Schedule

**Budget FY2001**
- Accounts Payable Records
  - [Retain three years, then destroy. General Retention and Disposition Schedule - Fiscal]
- Budget Preparation Files
  - [Contact the State Archives; if not accepted by the State Archives, then destroy. General Retention and Disposition Schedule - Administrative]
- Capital Improvement Projects Files
  - [Retain until no longer useful, then transfer to State Archives, in an acceptable format and accompanied by sufficient metadata for purging. General Retention and Disposition Schedule - Facilities Management]
  - Project 1
  - Project 2

- Payroll Adjustment Records
  - [Retain for three fiscal years, then destroy. General Retention and Disposition Schedule - Fiscal]

- Vendor Files
  - [Retain for three fiscal years, then destroy. General Retention and Disposition Schedule - Purchasing/Procurement]
  - Vendor A
  - Vendor B
Routine Correspondence & Memos [Retain until no longer useful, then destroy. General Retention and Disposition Schedule - Administrative]
- Project 1
- Project 2
- Person A
- Person B

Audit Reports [Retain five fiscal years, then destroy. General Retention and Disposition Schedule - Administrative]
- Department A
- Department B

Meeting Minutes (if e-mail version is the record copy) [Retain until no longer useful, then transfer to the State Archives, in an acceptable format and accompanied by sufficient metadata. General Retention and Disposition Schedule - Administrative]

Permanent Retention Messages

Policy Related Correspondence [Retain for five calendar years, then transfer to the State Archives, in an acceptable format and accompanied by sufficient metadata, for purging. General Retention and Disposition Schedule - Administrative]
- Project A
- Project B
- Issue 1
- Issue 2
APPENDIX II -- Filing Issues

E-mail messages can either be managed within the e-mail system itself, or outside of the e-mail system. Each method has its own advantages and disadvantages and the resources available to individual agencies will guide the direction an agency takes. This Appendix will outline the issues involved with each method.

Management of messages outside of an e-mail system can either be electronically on a shared network drive or by printing the messages and filing them in a paper-based record keeping system. In either case, the metadata associated with each message must be maintained in some fashion so that the link between the message and its metadata is maintained.

In the shared drive environment, a file structure can be set up with folders and sub-folders created in such a way that users can file their e-mail messages into the various categories (transitory, intermediate, and permanent) based upon retention. The agency records officer should work with the e-mail system administrator to create the file structure on the shared drive. When the user files a message on the shared drive, similar filenames can be used to show the relationship between a message and its metadata. The linkage between a message and any attachments will need to be maintained as well.

If messages are printed to paper and filed, a filing system should exist within the agency that facilitates the management of paper-based records. With paper printouts, the metadata will need to be printed and attached to the e-mail message. Another linkage, between message and any attachments, also needs to be maintained in order to preserve the connection between the message and its attachments. The agency records officer should already be working to manage the paper-based filing system according to the general or agency specific retention and disposition schedule.

Managing e-mail messages within the e-mail system has many advantages. Message metadata can be conserved. The links between messages and distribution lists and attachments can be more easily maintained. If e-mail messages are to be managed within the e-mail system, there are many factors that need to be considered in the design of the system to manage the messages effectively and efficiently. A file plan or structure should be built within the system that is tied to agency retention periods. As in the shared drive network environment, the agency records officer and the e-mail system administrator should work together to construct this file structure so that records issues are addressed.

The file structure should consist of shared folders where agency employees can file e-mail messages. These shared folders should be set up in such a way that messages can be added, and in most cases read, by employees, but no one can delete or alter the filed messages without proper authorization (through the system administrator/records officer) and in accordance with a general or agency-specific retention and disposition schedule. In order to protect the confidentiality of some messages, certain folders in the structure should be designated as “closed,” with permissions set so that records may be added to the folder, but not read by anyone except the filer and the administrator. However, all messages are subject to the Open Records Act unless the Act, or other state or federal legislation, exempts a category of public record.
If possible, the deletion of messages that have met retention requirements should be automated to streamline e-mail management. Not all e-mail systems allow automatic deletion of messages, but if so, the deletion cycle should be based upon retention periods established on the retention and disposition schedule.

In most cases, when a folder is created in an e-mail system, a description can be written that is attached to the properties of that folder. These descriptions are viewable by users by selecting the “Properties” item when right-clicking on the folder. This description should closely parallel the record series description from the retention and disposition schedule and can assist the user in understanding the folder titles when messages are filed. If retention codes, record series titles, or other standardized retention information are added at the end of message subject lines, it may be possible to automate the process of moving e-mail into folders. This is subject to the features found in individual e-mail systems.

As discussed in the following Appendix, filing of messages designated as records can be a complicated process and may require the use of tools such as a Records Management Application (RMA). A RMA is a relatively new type of software that helps users file and manage electronic records. It provides centralized filing and storage of electronic records, version control, search and retrieval, as well as other functions. RMA software is compatible with software products like GroupWise and the Microsoft Office Suite (Word, Excel, PowerPoint, Outlook), and makes the management of electronic records easier and faster than ever before.
Appendix III -- Technical Tips for Selected E-Mail Systems

Many brands of e-mail software are currently on the market or are coming to market in the future. Each system has its own functions and features, and while we do not endorse any one system, there are certain programs that are prevalent among Kansas governmental agencies. In this section we will highlight these common e-mail systems and discuss methods to facilitate the management of e-mail messages as records.

Novell GroupWise*

(Note: These technical tips were developed using GroupWise 5.5. There may be similarities to other versions of the software.) GroupWise is a groupware product, incorporating e-mail, calendar, and “to do list” features. The product also has potential as a document management system, which can be used in the management of e-mail messages. The user can set up folders in what is referred to as the “Cabinet,” which appears on the left side of the user screen as part of a “Folder List” (see figure 1).

Creating & Sharing Folders

All folders in the Folder List are subfolders of a user’s folder, or database, in the GroupWise system. To create a folder, select New→Folder from the File menu. The user can then select whether the folder is to be a personal folder (access given only to that user) or shared folder (access given to other users on the system). Then select Next. The next window allows the user to name the folder and write a description for the folder. By clicking Up, Down, Right, or Left, the user can position the folder within the “Cabinet.” Click Next. Display settings for the folder can be specified, and if the folder is a personal...
folder, click Finish and the folder appears under the “Cabinet” in the Folder List. If the folder is to be shared among a group of users, click Next. The next window has a field for Name, into which the name of users can be entered. Each user’s name is entered into this field, then the Add User button is clicked to move the user into the Share List. To grant access permissions to the users, click on the user’s name in the “Share List” and select the access options for each user. The options are Add, which allows a user to add items to the shared folder; Read, which grants the right to view or read an item; Edit, which allows a user to edit or change an item; and Delete, which controls who can delete an item. When the access options are granted to all users in the shared folder, click Finish to complete the process of creating the folder. If GroupWise is to be used in an agency to manage e-mail messages, we recommend that users be granted “Add” and, in most cases, Read permissions, but not Edit or Delete. If a folder is created for confidential, or Open Records Act exempted, messages, users should not be granted the right to read messages in that folder. If a user has permission to delete messages and accidentally deletes an item in a shared folder, only the creator, or “Owner” in GroupWise terms, can undelete the item (by selecting the item in the “Trash” and choosing Undelete from the Edit menu). The deleted item will appear in the owner’s trash, but not in the trash of the user who deleted it. (Items can also be undeleted by the “Drag and Drop” method where the user clicks on the item with the mouse and while holding the left mouse button down, drags the item to another folder and out of the trash.)

Attachments & Distribution Lists

File attachments and distribution lists, if larger than two kilobytes, are stored as individual files in the GroupWise post office’s file attachments directory. These files are encrypted with the GroupWise proprietary encryption technology and cannot be viewed or opened by standard document viewers or other programs.

Saving Messages

GroupWise also has an “Archive” feature which allows users to save e-mail messages outside of the system, but maintain the functionality of GroupWise. To archive an item, select the item by clicking once on it, then choose Archive from the Actions menu. This will move the item out of the user’s inbox and essentially out of the GroupWise system onto a shared network drive (depending on how the system is set up, a user’s archive may be part of the user’s directory on the network). To view the message again, select Open Archive from the File menu. The e-mail message can be read, but in order to reply or forward the message it must be moved out of the Archive (click on the message, and uncheck the Archive choice in the Actions menu). If a message in a personal folder is archived, the user’s Archive will show the message in the folder within the Archive. However, items in a shared folder can only be archived by the owner (creator) of the shared folder, and are not viewable by any user except the owner, including those with Read permissions.

If GroupWise messages are to be saved on a shared network drive outside of the GroupWise system, a two-step process is required. If the message is highlighted in the user database or if the message is open, the message can be saved by selecting Save As… from the File menu. This saves the message. To save the corresponding metadata, the user must select Properties from the File menu, then when the properties window is open, select Save As… from the File menu in that window. The user should give both the message and the metadata similar filenames so that the relationship between the two can be maintained. GroupWise will provide a filename for the message based on the e-mail subject by default (with an “*.mlm” file extension). But when the metadata, or properties, are saved, GroupWise will give a cryptic
filename, without file extension, to the file. The user can type in a new filename, and should give the file a name that relates it to the message. Agencies should develop policies outlining consistent naming conventions if this approach is taken.

Attachments can be saved outside of GroupWise by selecting Save As… from the File menu or clicking the Save button (a icon of a floppy disk with an ellipse) on the Message window. This will bring up the Save window; select the attachment and designate the filename and directory. (An alternative is to right-click on the Attachment icon and selecting Save As…, then entering a filename and choosing a directory within the Save As window.) As with saving metadata to a shared network, a naming convention should be followed that will intellectually link the attachment to the corresponding message.

Each method has implications on recordkeeping. Using the “Archive” feature within GroupWise guarantee that the saved messages can be read properly with the corresponding metadata, attachments and distribution lists. However, ensuring access to the messages in the future requires the maintenance of the GroupWise system, with upgrades and so forth, throughout the entire retention period of the saved messages. And going through the upgrade process does not guarantee that saved messages will be accessible with the new version. Policies or procedures that require messages to be saved by the “Archive” function will tie the agency to a proprietary system for the entire retention period of any records maintained in such a system as GroupWise.

Using the shared drive method will not require a proprietary system to be maintained over the life of the records in the system. This method does require users to go through the two-step process of saving messages, with related metadata and attachments. This burden can hamper the recordkeeping process since only the most conscientious user will follow it to ensure that the messages are preserved.

 Deleting Messages

When the user deletes a message from the inbox, the message is transferred to the user’s “Trash” folder. The message will remain in the “Trash” for a period of time, depending on the setting in the system. To change the settings, select Options from the Tools menu, and then double-click on Environment. In the Environment window, select the Cleanup tab. Cleanup allows the user to set the Empty Trash command to either manual or automatic after a set number of days.

GroupWise stores information in two databases: user databases and message databases. A user database is created for each user on the system and consists of the information in the user’s inbox, i.e., message subject heading, sender, date and time of receipt, etc. The message database is where the actual messages are stored. The software then creates pointers between the user or users and the messages. For example, if one user sends a message to one or more users within the same post office, GroupWise will store only one copy of the message in the message database and places a pointer to the message in each of the recipient’s user databases. When a recipient deletes the message, the user is actually only deleting the pointer to the message from the user’s database. The message remains in the message database until all users have deleted the pointer to the message from their user database, even if the Empty Trash time setting in a user’s database has expired. This is important to remember when managing “deleted” e-mail messages because the user can assume that a message has been deleted when it actually has not. As with all records, e-mail messages must be managed according to best records management practices, including proper disposition when the retention period has ended. If the message is not to be retained permanently, either within the agency or by transfer to the State Archives, then steps must be taken to ensure the proper
deletion or destruction of the message.

*Microsoft Outlook*

(Note: These technical tips were developed using Outlook 2000 and Outlook 98, with Outlook Express. There may be similarities to other versions of the software.) Outlook is similar to GroupWise in that it incorporates many of the same features (e-mail, scheduling, etc.). It does differ in how it names particular functions, and in the processes to set up folders and the like.

Creating & Sharing Folders

Outlook refers to the user interface as “Personal Folders.” The user can create additional folders in his or her Personal Folder, and the folders can be displayed in the “Folder List” (see Figure 2, left). These new folders also can be displayed under “Messages” on the “Outlook Today” view (as shown in Figure 2, right) by selecting Customize Outlook Today… (upper right of View), and clicking on Choose Folders button for Messages. The user can then check the folders to be displayed. To create a new folder, Click on File and select New → Folder, or click the on the New button and select Folder (also Ctrl+Shift+E keyboard shortcut). This brings up the Create New Folder window, which allows the user to give the Folder a name, and to select its contents and placement within the Personal Folder.

Folders can also be shared among users. To Share a folder, users should right-click on the folder they want to share, select Properties and choose the Permissions tab. Click Add to add users. Then permissions can be granted to individual users by highlighting a name and selecting individual
permissions. Outlook 98 provides the option of choosing one of nine “Roles” from a pull-down menu to simplify the process. Each role has a number of permissions preselected. The roles (with permissions, shown as checked boxes in permission window) are:

- **Owner** (create items, read items, create subfolders, folder owner, folder visible, edit all items, delete all items);
- **Publishing Editor** (create items, read items, create subfolders, folder visible, edit all items, delete all items);
- **Editor** (create items, read items, folder visible, edit all items, delete all items);
- **Publishing Author** (create items, read items, create subfolders, folder visible, edit own items, delete own items);
- **Author** (create items, read items, folder visible, edit own items, delete own items);
- **Nonediting Author** (create items, read items, folder visible);
- **Reviewer** (read items, folder visible);
- **Contributor** (create items, folder visible); or
- **None** may be selected to grant no permissions.

### Saving Messages

Outlook has a feature called “AutoArchive” which allows a user to clean up the inbox and to save messages. This feature controls the functions of the Deleted Items folder referred to above. The AutoArchive feature can be accessed through the Options item in the Tools menu. When the Options window opens, select the Other tab and click on the AutoArchive button. The user can then set when the command should be executed, whether a prompt is requested, and where the archive is in the file structure. This will then set the AutoArchive command for the user inbox; the user will have to repeat this for each subfolder. The global AutoArchive command must be set prior to setting each subfolder archive. To AutoArchive a subfolder, right-click on the subfolder and choose Properties. Then select the AutoArchive tab and determine the settings for this subfolder. Repeat this process for each subfolder. This process must also be repeated for the “Deleted Items” icon in the “Outlook Shortcuts” on the left side of the Outlook window (see Figure 2 above). The user can also Archive multiple folders at any time by selecting Archive… from the File menu. The command can then be executed on all folders based on their AutoArchive settings, or on individual folders based on a date. The AutoArchive process will run each time that Outlook is started.

To view items in the Archive, the user must first open the Archive. On the File menu, point to Open, and then click Personal Folders File (.pst). Then click on the file “archive.pst”. This will open the Archive file and add it to the Folder List. The Archive will recreate the folder directory structure, showing the archived item in the appropriate folder within any parent folders. When the Archive folder is opened in the Folder List, an item can be dragged from the Archive into another folder in the List.

Messages can also be saved as files. To save a file, highlight the message and select Save As… from the File menu. The message can be saved as a text file, as an Outlook template, in “Message Format,” or as an HTML-coded file. The user can also save a message while reading it by selecting Save or Save As… from the File menu. The user can also save attachments by selecting Save Attachments from the File
Deleting Messages

Deleting messages in both Outlook 2000 and 98 is as easy as right-clicking on an item and selecting **Delete** from the menu. Alternative methods include using the highlighting the item and using the **Delete** key on the keyboard or highlighting and selecting **Delete** from the **Edit** menu (or clicking on the **Delete** button). These steps also work while the user is reading the message. This will move the item to the **Deleted Items** folder (the “Recycle Bin” type icon in the **Outlook Shortcuts** column on the left of the **Outlook Today** window). Any items in the **Deleted Items** box will be removed from the system based upon the cycle set by the user. To set this cycle, right-click on the **Deleted Items** icon, choose Properties, and then click on the **AutoArchive** tab of the Properties window. Check the box for **Clean out items older than** and set the time period for the cycle. The user can then choose to either move items to a specified folder or permanently delete old items. Deciding to move items to a folder is best when items in folders other than the **Deleted Items** folder, in which case the user will probably want to permanently remove items from the system.

**Lotus Notes***

(These were developed using Lotus Notes version 4.6. There may be similarities to other versions of the software.) Lotus Notes is a product that integrates e-mail, calendar, to do list, and database features. Lotus Notes has a feature that allows the user to manage the storage of their e-mail messages by creating server-based folders that appear at the left of the user screen (see figure 1).

![Lotus Notes User Window showing folder list](image-url)
Creating & Sharing Folders

To create a folder, select Create and then Folder from the main menu. The user can then select whether the folder is to be a personal (access given to only that user folder) or shared folder (access given to other users on the server). Enter the name of the folder as illustrated in figure 2. You then have the option to check the shared button. To use a shared folder the owner must give access to the users they want to share with.

![Figure 2 – Screen shot of creating a new folder](image)

Saving Messages

In Lotus Notes a mail database is created for each user on the system. It consists of the information in the user’s inbox, i.e., message subject, sender, and date. All messages are stored on the server unless a user creates a local archive file. Archiving is a feature that allows users to save e-mail messages from their inbox and store it on their local hard drive but still maintain all the functionality of Lotus Notes. When a user archives a message at that point it is removed from the server.

If Lotus Notes messages are to be saved on a shared network drive outside of the Lotus Notes system, the message needs to be highlighted in the user mailbox, then select Export from the file menu. This saves the message in text format. To save the corresponding metadata, with the message open the user must right click on the metadata and select the detach option. The user should give both the message and the metadata similar filenames so that the relationship between the two can be maintained.

*Registered trademarks of the respective manufacturer.
Bibliography

